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Snapshot reports summarize key parts of your database, including jobs, costs, pay-
ables, receivables, and financials. These reports use information posted throughout 
Clients & Profits X, so they’re always accurate and timely. In this chapter you’ll see 
how to:

■  print production and traffic reports for open jobs and tasks
■  print job cost reports showing buyouts, time, and in-house expenses
■  print work in progress reports for billing
■  print client and vendor account agings
■  print productivity reports that analyze time
■  print profitability reports from jobs and tasks
■ print cash f lash reports
■ print financial statements
■ print media analysis reports

Introduction

For help using any part of Clients & Profits X, click the     button from any 
window to open the on-line user guide. This web-based user guide features 
step-by-step instructions, explanations, tips, demonstrations, and links to 
FAQs, tech notes, and tutorials from www.cnp-x.com/support.  The web site 
is continually updated, so it’s more timely and helpful than a printed user 
guide.
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Snapshot Reports

Snapshot reports provide a simple way to see essential information about 
the business. The idea behind snapshot reports is simple: Snapshot reports 
are designed to give managers quick “snapshots” of jobs, costs, billings, and 
financial information that are easy to print without programming. 

Snapshot reports summarize data from all parts of Clients & Profits X: Pro-
duction reports show status, traffic and schedules from jobs and tasks. Work 
in Progress reports show estimates, costs, and to-be-billed amounts from jobs 
and tasks. Job Cost reports summarize purchases, time, expenses, and checks 
by job, task, or client. Vendor Account Aging reports show unpaid invoices 
from Accounts Payable. Client Account Aging reports show unpaid invoices 
from Accounts Receivable. The Cash Flash window shows the current cash 
status—the current cash balance and outstanding account balances for A/R 
and A/P. Productivity reports show how time was spent from Time Sheets. 
Profitability reports show profit and loss from jobs and tasks. Financials 
are financial statements printed from your General Ledger. Media Analysis 
summarize client spending for different kinds of media from insertion and 
broadcast orders.

The snapshot reports are flexible, offering many options for selecting, 
sorting, and printing data. Snapshot reports do not replace reports found in 
the Job Tickets, Accounts Payable, and other windows; instead, they work 
together to give you the most complete picture possible of your work.

Printing snapshot reports is easy: Simply choose a command from the Snap-
shots menu, make your selections, then click Print. Report options determine 
how data will be selected, sorted, and printed. Your report can be printed 
to the window (for a quick on-screen review of the data), to the printer, or 
to disk as a word processor text file. Every snapshot window lets you select 
from various options, all of which make your report slightly different. That’s 
why there isn’t really one “snapshot” report for production, for example; 
different versions of the same basic report let you somewhat tailor the report 
to your exact needs. Some snapshot windows have more options than others, 
depending on what’s being printed.

■   Anyone can print snapshot reports if they have the proper access privi-
leges. If a user has access to a particular snapshot window, he or she can use 
any of the window’s reports and options. 

Snapshot reports vs. other reports

Snapshot reports consolidate data from all parts of your Clients & Profits X 
database, such as job tickets, accounts payable, time sheets, checkbook, and 
accounts receivable. They specialize in summarizing mammoth amounts of 
data into clear, concise reports. 

Snapshot reports use the same data as reports printed from Job Tickets, 
A/P, A/R, etc. So you’ll see the same data on a job summary printed from 
Job Tickets as you would on a Snapshot report. The difference is the snapshot 

Snapshot Reports

report shows many jobs—while a job report from Job Tickets usually shows 
one job ticket. 

The record-by-record detail for a snapshot report can always be printed 
separately. The individual time entries in a Productivity report, for example, 
can be printed as time reports from Time Sheets. Or, the journal entries that 
comprise the totals on your Balance Sheet can be printed in audit trails from 
the General Ledger.

Tips for printing snapshot reports

■  Printing reports to the window is faster than printing to the printer. 
A report can be reviewed more quickly when it’s on the window, since it 
doesn’t have to wait for the printer or the network. Once in the window, you 
can print one page or all pages using the Print pop-up menu at the top-right 
corner of the window.

■   Every snapshot window features a variety of options which affect how 
data appears on reports. This means you may get slightly different results 
when printing the same report over again. When you’ve finally discovered the 
right combination of options on a report, make a note on the report of the op-
tion you’ve chosen. So whenever someone else needs the same report, they’ll 
know the right options to use.

■  Managers can prevent users from printing certain kinds of snapshot reports 
by changing their access privileges: Choose Setup > Users, Access, and 
Privileges; from the Menus access options, uncheck the snapshot reports the 
user shouldn’t print; click Save. These changes will take affect the next time 
the user introduces himself or herself.

■  Any snapshot report can be printed to a disk as a text file. The text file, 
however, is unformatted (no fonts or styles). It can be opened by any word 
processor, but not a spreadsheet, then edited as needed.
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The Snapshots menu

Snapshots Reports

1 Production reports show sta-
tus, traffic and schedules from 
jobs and tasks. It’s the only way 
to get job status lists, traffic re-
ports, and job schedules for all 
of your jobs in production. Jobs 
can be selected by production 
or billing status. 

2 Work in Progress reports 
compare estimates, costs, open 
purchase orders, and unbilled 
costs from jobs and clients. 

3 Job Costs reports summarize 
purchases, time, expenses, and 
checks by job, task, or client—
every cost you’ve incurred for a 
week, month, or any period by 
client, job, or task. 

4 Vendor Account Aging reports 

show unpaid invoices from A/P. 
You can see unpaid invoices in 
detail, or just see each vendor’s 
balance due. The vendor aging 
can be run as of the current 
date or through any prior 
period. Client Account Aging 
reports show unpaid invoices 
from Accounts Receivable. You 
can see each unpaid invoice, 
or just the total balance due 
for each client. Invoice aging 
reports have many options; for 
example, you can print an aging 
for one client or for all clients 
within one division. The client 
aging can be run as of the cur-
rent date or through any prior 
period.

5 The Cash Flash window shows 
your current cash balance and 

outstanding A/P and A/R bal-
ances. A schedule of payments 
and cash receipts can be set 
up to help you plan your cash 
needs.

6 Profitability reports show 
profit and loss from jobs and 
tasks. You can analyze the job’s 
profit to date, or just profit 
earned for the month’s billings 
and costs.

7 Productivity reports show 
how time was spent from Time 
Sheets. You can quickly see 
how your staff is utilizing their 
time by client, department, 
or profit center—for a week, a 
month, or any period of time. 
There are reports to analyze 
overtime and show you which 

staff members have not ac-
counted for all their hours.

8 Financials include the 
Income Statement, Balance 
Sheet, Trial Balance, Detailed 
General Ledger, and Statement 
of Cash Flows. You can print 
financials anytime during the 
month, seeing your up-to-the-
minute balances. The financials 
can be run for any of the 24 
accounting periods or quarterly 
financials can be run. 

9  Media Analysis reports can 
be used by media buyers and 
account service to see how 
advertising was purchased.  Ac-
count management can use me-
dia analysis reports to  analyze 
how well the media department 
is managing themselves.
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Production Reports

Production Reports

Production reports are your best source of up-to-date information on 
open jobs, traffic, and task schedules. A complete picture of your work 
in production is available here: job status lists, traffic reports showing mile-
stones, work-to-do schedules for tasks and resources, and a customizable 
schedule chart that shows selected unfinished tasks.

The Job Hot Sheet reports show jobs by production status, sorted by job 
number. Each job shows its job 
number, job name, client, and 
status. The Job Hot Sheet can 
show jobs selected for a range 
of start dates, due dates, added 
dates, or closed dates. It’s like 
the job lists you can also print 
from the Job Ticket window.

Traffic reports show jobs by 
production status, and feature 
milestones. Jobs are grouped by 
job type, so that like jobs are 
shown together. The traffic re-
ports can be run for one client, 
AE, or one of six key production 
people. The job’s status note 
(which is a customizable status 
code entered in the job’s Traffic 
window) appears on the right 
side of the report. If you use 
FileMaker, this report is prob-
ably very similar to the job report you’re now using. 

Schedules/work to do reports show unfinished job tasks by resource, client, 
AE, department, or task. These work-to-do reports can be printed daily to 
show everyone what they’re to do each day. Or, weekly schedules can be 
printed in advance for production meetings to help manage the week’s work 
load.

The schedule chart is a combination traffic/schedule report. It charts a 
user-defined selection of tasks by due date. You can pick-and-choose the 
unfinished tasks you want to see, sorted by job number. You can also sort the 
unfinished tasks by client. So instead of seeing every unfinished task for the 
week, you can print just ART, COPY, and DES (i.e., design) instead. Any com-
bination of tasks can be charted. This ability lets you easily chart work-to-do 
for different work groups, such as creative teams. For flexibility, the chart’s 
title is even customizable.

The analysis reports allow you to see which tasks were completed on time 
and which were late, or a list of missed deadlines can be printed for each 
staff member

■ Each of the production reports has its own unique purpose. You may not 
need every one to help you manage your jobs. Instead of printing every 
report, experiment with each report (and its various options) to see which one 
gives you the best information you need to keep track of jobs.

To print production reports

Each production report has its 
own selections, which don’t 
affect the other reports. For 
example, you can print a status 
report listing jobs with status 
1-50, while also printing a 
traffic report showing jobs with 
status 1-999. 

1  Choose Production from the 
Snapshots menu.

2  Select the kind of report (i.e., 
Hot Sheets, Traffic, Schedules/
Work to Do).

3  Make your report selections.

4  Click Print.

Production reports with more 
information will take longer to print than shorter reports.

Tips for printing production reports

■ Use the Job Hot Sheet as your basic production report. Since it shows the 
job’s key facts—job number, job name, client, due date, production status, 
and status notes—it’s a great way to see your open jobs at a glance. If you 
need to see more detail about a job, print a job summary (from Job Tickets).

■ Production reports are less detailed than regular job reports. Job lists 
printed from Job Tickets, for example, include many more options (such as 
showing the job specifications). However, other job reports are longer since 
they show more information. This makes them a little more complicated, 
since there are more pages used.

■ Don’t use production reports for billing. Since production reports are 
designed to manage work in production, you won’t see estimates, costs, 
billing, or other amounts. Instead, print either Work in Progress reports (from 
Snapshots) or job lists and job summaries (from Job Tickets).
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Production Reports

Production Reports

Job Hot Sheet

Traffic Hot Sheet

Traffic by Job Type

Traffic by Client

Traffic by Job Number

Traffic by Production Status

Traffic by AE/Team

Work to Do (by Due Date)

Work to Do (by Start Date)

Daily Task Calendar

Client Deadlines

Department Task Checklist

Job Schedule

Schedule Chart

On-Time Performance

Missed Deadlines

The Job Hot Sheet shows the job’s key facts—job number, production status, and status notes.

The Traffic Hot Sheet shows the job’s number, production status, and traffic assignments.

The Traffic by Job Type report lists each job within a job type and shows each jobs’ milestones 
and status notes. Each job type prints on a separate page.

The Traffic by Client report lists each clients’ jobs by job type, showing the jobs’ milestones. A 
separate page is printed for each client’s jobs.

This report lists each jobs’ milestones and sorts the jobs within each job type by job number. 

This traffic reports shows each jobs’ milestones, sorting jobs within each job type by produc-
tion status.

The Traffic by AE/Team lists job milestones and sorts the jobs within each job type by AE/Team.
 

The Work to Do report (by Due Date) shows unfinished tasks by due date and sorts by resource.

The Work to Do (by Start Date) shows unfinished tasks by start date and sorts by resource.

This report shows a checklist of unfinished tasks by due date. The client, job, resource, and 
time of day each task is due is listed with a check box so the printed report can be used as a 
manual checklist.

The Client Deadlines report shows unfinished tasks for each client and sorts them by due date. 
The job number, job name, resource, and time due are listed for each task.

The Department Tasks Checklist shows unfinished tasks for each department, sorted by due 
date. The task’s due date, time due and resource are shown along with the resource’s backup 
person.

The Job Schedule report gives a list of unfinished tasks by start or due date.  For each task the 
estimate hours and hours remaining are shown.

The Schedule Chart lets you choose the unfinished tasks you want to see and sorts them by job 
number or client. So instead of seeing every unfinished task for the week you can print just a 
select few (e.g., artwork, copy writing, and design).

The On-Time Performance report compares the due date of each client’s unfinished tasks to 
the actual date the task was finished. The number of days the task was late is calculated and 
the performance of meeting the due dates is analyzed by showing what percentage of the tasks 
were early, on-time, late, or very late.

The Missed Deadlines report shows tasks that were finished after the scheduled due date for 
each person. The number of days the task was late is calculated.

Production Hot Sheets

Traffic Reports

Schedule/Work To Do Reports

Schedule Charts

Production Analysis Reports
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profit center by using the select by pop-up menu. They can show unbilled 
costs by production status or billing status, letting you see only jobs marked 
as ready to bill, for example. By using billing status, accounting managers 
can print their own reports.

Change orders aren’t costs, so don’t appear on the work in progress reports. 
Since they may influence a month’s billing, change order reports and forms 

can be printed from the Work in 
Progress window. The Change 
Order Report lists change orders 
for all jobs for a range of dates. 
The option change orders prints 
a list of all change orders for a 
time period.

■ Tasks without unbilled costs 
aren’t included on work in 
progress reports. 

Billing worksheet re-
port options include:

■ Include overbilled tasks. 
Only unbilled tasks appear on 
WIP reports. Overbilled tasks 
(which may have been billed by 
estimates) aren’t included. Why 

exclude overbilled tasks? These amounts will decrease the unbilled total for 
the job, and you may not bill enough to cover the job’s actual costs. Since 
the job summary and job progress reports show all tasks, you should use this 
option if you compare them with work in progress reports. 

■ Show overbilled jobs. This option looks at the unbilled total of the job, 
rather than the individual tasks. If the unbilled total on the job is a negative 
amount (i.e., the job is overbilled), then the job will not appear on the report 
unless this option is selected.

To print work in progress reports

1  Choose Work in Progress from the Snapshot menu.

2  Select the kind of report (i.e., Billing Worksheets, Unbilled Costs, Unbilled 
Media, etc.).

3  Make your report selection.

4  Click Print.

Work in Progress Reports

Work in progress reports are based on jobs and tasks—and not general ledger 
journal entries. Unlike older agency accounting systems, the general ledger 
does not automatically track your unbilled costs. This is done for two reasons: 
(1) Clients & Profits can track costs and billing without needing the General 
Ledger, which other systems can’t; and (2) only actual costs and billings af-
fect the general ledger anyway.

Here’s how it works: When a 
vendor invoice or check is add-
ed, every line item gets a debit 
account (typically a job cost or 
expense). During posting, the 
line item amount debits the gen-
eral ledger—increasing the cost 
or expense account’s balance. 
The entry is counted as a cost 
against income immediately; it 
is not counted as an asset. When 
the job is billed, an income ac-
count is credited and Accounts 
Receivable is debited—that’s all. 
Billing does not affect your cost 
or expense accounts.

Here’s why: The system assumes 
that you’ll bill costs in the same 
period that they’re entered. It’s 
simpler, since agencies can bill 
costs more quickly now with Clients & Profits. This eliminates the need to 
initially post costs to WIP, then reverse the costs that were later billed. So in-
stead of booking the month’s costs as they’re added, you only need to make 
a month-end entry for the value of unbilled costs. And you’ll get this amount 
from the work in progress reports.

This method of cost accounting only applies to payables and checks. 
Purchase orders, insertion order, time sheets, out-of-pocket expenses, cost 
transfers, and job change orders don’t post journal entries into the general 
ledger Work in progress reports summarize unbilled costs. These reports are 
the best way to see what you’ve spent on jobs so far, even if they’ve been 
billed before. Work in progress reports can show what’s to be billed by client, 
making the month’s billing easier. Other reports help you account for your 
change orders.

The various work in progress reports show jobs, tasks, and costs in differ-
ent ways, so have different purposes. The Billing Hot Sheet report is a great 
pre-billing report, since it lists your unbilled jobs by client. It summarizes the 
unbilled totals by job, so it is a very compact report; however, it doesn’t show 
much detail.  

WIP reports can show jobs, tasks, and costs for one client, AE, project, or 

Work in Progress Reports
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Work in Progress Reports

Work in Progress Reports

Billing Hot Sheet

Job Billing Worksheet

Unbilled Costs by Job

Unbilled Costs by Task

Partially-Billed Costs

Costs On-Hold

Unbilled Media (all kinds)

Unbilled Broadcast Orders

Unbilled Insertion Orders

Write-offs

Markdowns

Overbilled Tasks

Unbillable Costs

G/L Accrual (Costs by dGL)

Change Orders

The Billing Hot Sheet shows unbilled jobs by client—including each job’s estimate (plus 
change orders), billed, and remaining unbilled amounts. A checklist of the billing work-
flow steps is listed for each job.

The Job Billing Worksheet shows unbilled jobs and their tasks—including each task’s 
budget, costs, commitments, billings-to-date, and a space to enter the amount to bill 
now. Every job is printed on its own page, making the report easy to distribute to AEs. 

The Unbilled costs by Job report can be selected by cost status. This option lets you 
see unbilled costs that are on-hold, for example, or cancelled. All other costs will be 
excluded from the report.

The Unbilled Costs by Task report lists unbilled vendor purchases, time entries, 
expenses, checks, and transfers by task. Use this to easily see total unbilled printing, 
layout, etc. at month-end. To see unbilled costs for a time period, choose Job Costs from 
the Snapshots menu.

The Partially-Billed Costs report lists any cost with a status of Partial. The costs are 
sorted by client, then job.

The Costs On-Hold report lists any cost with a status of On-Hold.

The Unbilled Media (all kinds) report lists all insertion and broadcast orders that have 
not been billed to the client. The orders are grouped by client and sorted by order 
number.

The Unbilled Broadcast Orders lists all broadcast order not yet billed to the client. Each 
broadcast order is listed with its station, flight dates, number of spots, and net and 
gross amounts. A separate page is printed for each client’s orders.

The Unbilled Insertion Orders lists all insertion orders not yet billed to the client. Each 
insertion order is listed with its publication, issue date, ad size, and gross amount. A 
separate page is printed for each client’s orders.

The Write-offs report analyzes costs that have been written off for some time period.

The Markdowns report shows costs that have been billed for less than their gross 
amounts.

The Overbilled Tasks lists job tasks that have been billed for more than their actual 
costs.

The Unbillable Costs report lists unbillable costs by job or task.

The G/L Accrual summarizes unbilled job costs by debit G/L# for making manual WIP 
entries.

The Change Orders report lists change orders added for any time period.

Billing Worksheets

Unbilled Costs

Unbilled Media

Analysis

Miscellaneous
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date, including billing information. Costs can also be sorted by kind, instead 
of task.

■ To see time in detail by day: Choose Accounting > Time Sheets then choose 
File > Print Time Reports. Enter a range of dates, then click Print. Time re-
ports show time by day, staff member, job, task, or client. In addition, you can 
print time entries by date added or date posted, unlike the Job Cost reports.

■ To see time totals: Choose 
Productivity from the Snap-
shots menu; enter a range 
of work dates; select some 
options; then click Print. 
The productivity reports 
summarize time sheets in 
various ways. You’ll see 
clear, concise totals and not 
all of the time detail, making 
it a very efficient, effective 
management report.

To print Job Cost 
Reports

1  Choose Snapshots > Job 
Costs.

2  Select the kind of report 
(i.e., Job Costs, Client Job 
Costs, Task Costs, etc.)

3  Make your report selections.

4  Click Print.

Tips for printing job cost reports

■ Only posted costs appear on Job Cost reports. Unposted costs, including 
unposted daily time cards, are simply excluded until they are posted.

■ If a user doesn’t have access to cost amounts, they will not be able to print 
Job Cost reports, so there’s no way for the user to see cost rates and net 
amounts.

Job Cost Reports

Job cost reports are very detailed listings of vendor purchases (buyouts), time 
sheets, checks written for job costs, out-of-pocket expenses, and job cost 
transfers. 

Job costs are selected by work date (i.e., when the time was used, the 
vendor’s invoice date, or the date a check was written for job costs) or posted 
date. This makes it easy to see what you bought and where you spent your 
time for a week, month, or 
any time period. In addition, 
costs can be sorted by job 
number, client, or task for 
better analysis. 

The basic job cost report 
shows each cost’s refer-
ence number (i.e., invoice 
number, check number, time 
ID number), date, vendor or 
staff member, job number, 
task, hours (if it is a time 
entry), net cost amount and 
gross amount. As an option, 
you can show the cost’s 
notes.

You’ve got a substantial 
amount of control over 
how the report is arranged. 
Cost reports can be printed 
showing any combination of 
vendor costs, time entries, expenses, and cost transfers. 

Since costs are connected to jobs, you can print cost reports using status 
codes. You can select costs by the job’s production or billing status. This abil-
ity lets you see job costs, for example, for only open jobs. Or, you can print 
job costs for closed jobs, jobs on hold, etc. You can also show costs for one 
job number, one client, or one task. There’s no limit to how you can print job 
cost reports.

■ Purchase orders are not job costs (yet), but a purchase/insertion order 
report can be printed from the Job Cost Report window.

Job Cost reports vs. other cost reports

The Job Cost report is best for seeing costs for all jobs for some time period. 
But there are other reports that may be more useful in different situations, for 
different needs.

■ To see the costs for one job only: Choose View > Job Tickets then find 
the job you want. Then choose File > Print Job Reports, select the job 
cost report, then click Print. This report prints all costs, regardless of 

Job Cost Reports
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Job Cost Reports

Job Cost Reports

Job Costs

Client Job Costs

Task Costs

Purchase Orders

Change Orders

The Job Costs report is simple, showing costs by job and task. All costs can be selected or 
any combination of outside costs, time, in-house expenses, or internal charges.

The Client Job Costs report shows costs by client, then by job number. A separate page is 
printed for each client. All costs can be selected or any combination of outside costs, time, 
in-house expenses, or internal charges. 

The Task Costs report shows costs by client first, then by job task. You’ll see how time and 
money was spent by client, task, and the vendor or staff member. A separate page is printed 
for each client, too. 

The Purchase Order report can be printed for one or all types of orders (broadcast, insertion, 
purchase).  Each order’s number, vendor, date, cost, gross, and balance is shown.

The Change Order report can be printed for approved or unapproved orders. Each change 
order’s number, date, description, and status are shown, along with the hours, budget, and 
estimate amounts being changed.

Job Costs

Client Job Costs

Purchase Orders/Insertion Orders

Change Orders

Task Costs
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Vendor Account Aging

Vendor aging reports show unpaid invoices from Accounts Payable. These 
reports show how much you owe to vendors. Both show essentially the same 
information—accounts payable—but in more or less detail. The Vendor Invoice 
Aging shows individual unpaid invoices by vendor. The Vendor Account Aging 
doesn’t show invoices; instead, it shows account totals only. 

Both reports are useful to management, but have different purposes. The 
Vendor Invoice Aging shows every unpaid invoice, along with the aged 
balances. It’s most commonly used when preparing to write checks, since it 
can be used as a checklist of the bills to pay. The invoice aging can be a long 
report if you have large unpaid balances. The Vendor Account Aging is a short 
report, since it shows only one line per vendor—but may not show enough 
information to help plan your cash requirements. Its most practical use is to 
quickly see to whom you owe money.

Vendor agings can be printed any time during the month, but especially at 
month-end. Vendor aging reports are always up-to-the-minute accurate, 
showing any posted invoice with a balance due. They can show what you 
owe as of the moment the report is printed or what was owed through a prior 
accounting period.

Vendor account balances can be aged into the current period and three 
user-defined periods (e.g., 30, 60, 90 days). These periods are flexible and 
can be changed any time the agings are printed. Any set of aging periods can 
be used. The aging option recalculates the unpaid balance based on today’s 
date and your aging periods. Your aged balances will only be accurate as of 
the last aging.

Vendor agings and the General Ledger

Vendor aging reports aren’t based on data from the General Ledger. Instead, 
vendor aging reports are based exclusively on unpaid invoices from Accounts 
Payable. So what you’re seeing on vendor agings comes from your payables, 
not from journal entries. 

For this reason, they have the potential to be confusing. The vendor aging 
reports show a grand total at the bottom of each report. The balances on the 
vendor invoice aging will always match the vendor account aging—they’re 
both based on unpaid payables, after all. Since Accounts Payable is inte-
grated with your General Ledger, your payables’ balances on the Balance 
Sheet should equal the balances on the aging reports. In some cases, they 
won’t match—for an obvious reason: journal entries posted directly into the 
General Ledger for the A/P account do not affect vendor balances, and there-
fore the vendor account agings. For this reason, don’t make adjusting entries 
to the G/L for the A/P account; instead, make your adjustment directly into 
Accounts Payable.

Vendor agings can be printed for some date in the past. The total balance 
due should always match the Balance Sheet printed for the same accounting 
period.

Vendor Account Aging

To print a vendor aging report

1  Choose Snapshots > Vendor Account Aging.

2  Choose the kind of aging report (i.e., Invoice Aging or Account Aging).

3  Select to show balances through today or through a prior period.

4  Enter your aging periods.

These periods are used to calculate aged balances for every invoice, based 
on the invoice date and today’s date. You can use any set of aging periods, 
including a different set each time you print vendor agings.

5 Choose your aging options.

To see only invoices for one vendor, enter the vendor code, or use ALL for 
all vendors. To see invoices for one specific A/P account, enter the payable 
account number.

6 Click Print.

The aging process can take some time if you have many unpaid payables. 
Since aging is a demanding procedure, it’s best to age your accounts when 
few users are using Clients & Profits Pro. Here’s what happens: Clients & 
Profits Pro first clears the existing balances for every vendor. Next, the 
program checks Accounts Payable for unpaid invoices. Every unpaid payable 
is evaluated, and its balance aged based on the invoice’s date, today’s date, 
and your aging periods. The invoice then updates the vendor’s balances.

■  The Client Paid column on the Invoice Aging report helps you pay only 
the A/P invoices that have been billed and paid by the client.  When a client 
pays their A/R invoice, the A/P invoices billed on that invoice are updated 
with the date the client paid.  In order for the Client Paid column to be 
updated, the accounts payable invoice must be posted first, then the client is 
billed with an accounts receivable invoice that bills the actual cost, next the 
accounts receivable invoice that bills the cost needs to be paid.
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The Vendor Account Aging window

Vendor Account Aging

1  The aging report can be pre-
viewed on-screen by choosing 
Screen from the Print to pop-up 
menu. The report can also be 
exported to a spreadsheet by 
choosing Export from the pop-
up menu.

2  The Invoice Aging report 
shows 
all unpaid payables, subtotaled 
by vendor number. Use this op-
tion to see everything you owe, 
in detail. 

3  The Account Aging report 
shows totals by vendor only, 
and not unpaid payables. The 
vendor’s unpaid invoices roll up 
into the account totals, making 

the report more concise.

4  The show balances through 
option allows you to select to 
age the balances as of today or 
through a prior period.

5  Choose to print the aging 
report for one vendor or type 
ALL to select invoices for all 
vendors.

6  Aging periods are customiz-
able. They are used to catego-
rize unpaid payables by their 
relative age. For flexibility, any 
set of aging periods can be 
used. 

7  The vendor invoice ag-
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ing report has an option to 
subtotal invoices for a selected 
A/P account, such as a media 
payables account. This option 
prints  a smaller report, since 
only media payables (for exam-
ple) would be printed. To print 
an invoice aging report for one 
A/P account, enter the account 
number here. Use this option 
to print an aging report for only 
media payables, for example. 
Any invoice with this credit 
G/L# will be printed; the others 
will be excluded. To combine 
invoices from all A/P accounts 
together on the same report, 
leave this option unchecked.
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Client Account Aging

Client aging reports show unpaid invoices from Accounts Receivable. These 
reports show how much clients owe you. Both show essentially the same in-
formation—accounts receivable—but in more or less detail. The Client Invoice 
Aging shows individual unpaid invoices by client. The Client Account Aging 
doesn’t show invoices; instead, it shows account totals only. 

Both reports are useful to management, but have different purposes. The Cli-
ent Invoice Aging shows every unpaid invoice, along with the aged balances. 
It’s most often used to track down late-paying clients and their invoices. 
The invoice aging can be a long report if you have a large number of unpaid 
invoices. The Client Account Aging is a short report, since it shows only one 
line per client—but may not show enough information to help plan your cash 
requirements. Its most practical use is to quickly see who owes you money.

Client agings can be printed any time during the month, but especially at 
month-end. Client aging reports are always up-to-the-minute accurate, show-
ing any posted invoice with a balance due. They can show what the client 
owes as of the moment the report is printed or through a prior period. For 
better accountability, unpaid invoices can be selected for one A/R account.

Client account balances can be aged into the current period and three user-
defined periods (e.g., 30, 60, 90 days). These periods are flexible and can 
be changed any time the agings are printed. Any set of aging periods can be 
used. The aging option recalculates the unpaid balance based on today’s date 
and your aging periods. Your aged balances will only be accurate as of the 
last aging.

Client agings and the General Ledger

Client aging reports aren’t based on data from the General Ledger. Instead, 
client aging reports are based exclusively on unpaid invoices from Accounts 
Receivable. So what you’re seeing on client agings comes from your receiv-
ables, not from journal entries. 

For this reason, they have the potential to be confusing. The client aging 
reports show a grand total at the bottom of each report. The balances on the 
client invoice aging will always match the client account aging—they’re both 
based on unpaid receivables, after all. Since Accounts Receivable is inte-
grated with your General Ledger, your receivables’ balances on the Balance 
Sheet should equal the balances on the aging reports. In some cases, they 
won’t match—for an obvious reason: journal entries posted directly into the 
General Ledger for the A/R account do not affect client balances, and there-
fore the client account agings. For this reason, don’t make adjusting entries 
to the G/L for the A/R account; instead, make your adjustment directly into 
Accounts Receivable.

Client agings can be printed for some date in the past. The total balance due 
should always match the Balance Sheet printed for the same accounting 
period.

Client Account Aging

To print a client aging report

1  Choose Snapshots > Client Account Aging.

2  Choose the kind of aging report (i.e., Invoice Aging, Account Aging, or 
Retainer Aging)

3  Select to show balances through today or through a prior period.

4  Enter your aging periods.

These periods are used to calculate aged balances for every invoice, based 
on the invoice date and today’s date. You can use any set of aging periods, 
including a different set each time you print client agings.

5 Choose your aging options.

To see invoices for one specific A/R account, enter the receivable account 
number.

6 Click Print.
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The Client Account Aging window

Client Account Aging

1  The aging report can be pre-
viewed on-screen by choosing 
Screen from the print to pop-up 
menu. The report can also be 
exported to a spreadsheet by 
choosing Export from the pop-
up menu.

2  The Invoice Aging report 
shows all unpaid receivables, 
subtotaled by client number. 

3  The Account Aging report 
shows totals by client only, and 
not unpaid receivables. 

4  Use the Retainer Aging 
report to print an aging report 
showing only clients with 
retainer balances.

5  The show balances through 
option allows you to run the cli-
ent aging as of today or through 
a prior period.

6  Choose to run the client ag-
ing for one client by entering a 
client number here. To print the 
aging for a particular division 
and its clients, choose divisions 
from the for pop-up menu 
then enter the division’s client 
number. 

7  Invoices are aged based on 
aging periods. These periods are 
used to calculate aged balances 
for every invoice, based on the 
invoice date.

8  Use the subtotal invoices 
for a selected A/R account to 
print invoices for a selected A/R 
account.

9  The apply finance charges 
first option will apply a finance 
charge to any invoice with a 
30-day-or-greater balance. 
The show YTD billings option 
displays the client’s year-to-date 
billings on the aging report. The 
show client names option shows 
(or hides) the client’s organiza-
tion name on the printed aging 
report. 
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Cash Flash

Cash Flash

Cash f lash reports show unpaid receivables and unpaid payables, as well as 
scheduled payments and deposits, for any time period. They are based on 
invoices from Accounts Payable and Accounts Receivable, as well as sched-
uled entries entered in the Cash Flash window. The Cash Flash report helps 
you plan your cash requirements by comparing expected client payments and 
deposits with planned vendor payments and other outlays. 

Cash f low reports can select unpaid 
invoices for any range of pay dates. An 
invoice’s pay date can be edited anytime, 
even if it is posted. Since cash f low 
reports only show unpaid client or vendor 
invoices, they don’t include any payment 
not posted into A/P or A/R. Your rent 
check, for example, won’t appear on the 
cash f low report unless the landlord’s 
invoice is added into Accounts Payable.

To update today’s balances

1  Choose Snapshots > Cash Flash.

2  Click the  (i.e., Update Now) 
button. 

Clients & Profits adds up the current 
bank balances from the 
G/L accounts marked with a cash 
f low category as Cash, the vendor 
balances from the A/P aging, and the
 client balances from the A/R aging. 
Today’s payments and checks are 
calculating the day’s posted client 
payments and checked.

To send today’s cash flash 
via e-mail

1  From the Cash Flash window, click the 

 (i.e., Send Mail) button.

The Cash Flash can be sent to any active staff member. You’ll be prompted to 
select a staff member’s name, then enter a note (which is added to the body 
of the e-mail message). The cash f lash can also be cc’d to two additional 
e-mail addresses.

■  Since the shop’s account balances are highly confidential, be careful to 
only send the cash f lash to an authorized staff member.

To print the cash flash report

1  From the Cash Flash window, click the  (i.e., Print) button.

To add a cash flow calendar entry

1  From the Cash Flash window, click 

the  (i.e., Add) button.

2  Enter the scheduled payment or 
deposit’s date and amount.

If the entry is for a payment (cash out) 
the amount needs to be entered as a 
negative amount.

3  Enter who the money will be sent to 
or received from and a description.

4  Select to notify a staff member via 
e-mail of entry, then click OK.

To repeat a scheduled cash 
flash entry

Cash flash entries can be scheduled to 
repeat many times. To repeat an entry, 
select it in the Cash Flash window 

then click the  (i.e., Repeat) button. The Repeat Entry dialog box opens, 
prompting you to enter the repeat interval (i.e., the number of days between 
entries), the number of times when the entry should be repeated, and when 
the scheduled entries should start. These entries only affect the Cash Flash 
window and report, and have no affect on A/P, A/R, or the General Ledger. 
They’re simple reminders for better cash management.

Scheduling future payments. 
Upcoming cash outlays can 
be easily scheduled in the 
Cash Flow Calendar. Incoming 
deposits (e.g., tax refunds, 
proceeds from asset sales, 
royalties, etc.) can also be 
scheduled. Notification of cash 
flow entries will be e-mailed to 
any selected staff member on 
the day it is due.
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The Cash Flow window

Cash Flash

1 Click on the update button 
to update today’s cash flow 
and account balances. Click 
the print button to print the 
cash flash report or other cash 
reports. Click on the e-mail 
button to generate an e-mail 
message with the cash flash 
information.

2 Click these buttons to add, 
edit, or delete a scheduled pay-
ment or deposit.

3 Click the repeat button to set 
a schedule to repeat a sched-
uled payment or deposit.

4 The ending cash balance 
for the day is then calculated 

based on the beginning cash 
balance and any payments and 
checks recorded today. 

5 The current client and vendor 
aged balances are listed to help 
plan your cash requirements by 
comparing expected client pay-
ments with outstanding vendor 
payments.

6 Select to view a different 
month’s scheduled payments 
and deposits from the month 
pop-up menu.

7 When you click on a day in 
the Cash Flow Calendar you’ll 
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see the day’s scheduled entries. 
Double-clicking on an entry lets 
you edit it.
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Profitability Reports

There are many kinds of job profitability reports. Each report gets its informa-
tion from a different source, so each has a slightly different focus—and 
usefulness. The Job Profitability reports show costs, time, and billings for jobs 
and tasks. The Client Profitability reports are based on journal entries from 
the General Ledger, including overhead expenses you’ve directly allocated to 
clients, for one accounting period. The Gross Margin report compares costs, 
time, expenses, and billings for a week, a month, or any period of time—so 
it’s the most flexible way to track your shop’s performance.

The foundation of the Job 
Profitability reports is the 
job task. Jobs remember 
everything purchased and 
billed by job task. Job tasks 
keep job-to-date totals 
for costs, time, expenses, 
and billings from the date 
the job was started. Since 
job tasks are connected to 
jobs and clients, they are 
an ideal basis for analyzing 
profitability. Job-to-date 
profitability reports search 
for job tasks for a period of 
time (using the job’s start 
date) and billing status 
(such as closed jobs, for 
example). These tasks are 
rearranged, subtotaled, 
and printed by job, project, 
client, task, etc. based on 
the options selected in the 
Profitability window. In most cases, the job tasks themselves are hidden to 
save space; what you see instead are just the job’s totals. These totals are 
based on the same job tasks you’d see in a Job Summary report.

■ The Job P&L and Client P&L, which is based on G/L journal entries from 
billing and job costs, is printed from Financials. Every journal entry can be 
given a client number and a job number. If a journal entry has a job number, 
it is selected for the job income statement. The Job P&L is printed for one 
accounting period, just like the agency’s income statement. It can reflect 
the client’s overhead allocation, if entered into the Overhead Allocation 
Worksheet. You can print the report for one job or one client.  The job income 
statement doesn’t show time, expenses, or any other amount not posted in 
the General Ledger—so it may be drastically different (and probably less ac-
curate) then the other profitability reports. 

The Gross Margin report compares costs and profit for any period of time, 
such as a month or a quarter. This report is distinctive because it shows 
profit both before and after labor. Direct costs are the total vendor purchases, 
checks, and expenses. Net Revenue is billings less direct costs. Direct Labor 

is the total time cost for the month. Profit is net revenue less direct labor. 
Jobs are subtotaled by client for easy comparison. The last bill date is shown 
from the last invoice billed for the job.

Job profitability vs. agency profitability

You can see profitability two ways: Job profit is focused on job costs—
vendor purchases, labor, cash disbursements from checks, and out-of-pocket 

expenses—and job billings. 
Agency profit is based 
strictly on income and 
expenses for everything—
whether they were the result 
of jobs or not. 

You can’t rely on just one 
profit report to keep you 
informed. Job profitability 
and the income statement 
emphasize different things: 
job profitability reports are 
based solely on jobs, tasks, 
and clients; income state-
ments are based only on the 
general ledger.

Job profitability shows only 
costs and billings for jobs 
and tasks, and does not ac-
count for overhead expenses 
like rent. Income statements 

don’t reflect the cost of time spent working on jobs, only the total payroll 
expense. Income statements take into account other non-job income, like 
fees and interest income; job profitability doesn’t reflect adjusting entries to 
the General Ledger.

What’s the difference between gross margin and net income? Gross margin, 
as it is used in Clients & Profits, is based on jobs and tasks. 
It is the difference between a task’s billings and its costs—vendor purchases, 
time sheets, and expenses. Net income, as it is used on the income state-
ment, is the agency’s real profit after overhead expenses.

Job Profitability vs. the Income Statement

Both reports show important information about how well you’re doing. Job 
profitability shows exactly where your revenue is being earned, even showing 
each client’s total contribution to profit. Income statements can’t show this 
kind of detail without a lot of extra work on your accountant’s 
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part. However, the job profitability doesn’t include overhead—so it’s not a 
complete picture either. When used together, both reports provide the com-
plete picture you need to stay informed. Differences include:

Job Profitability
	 	 	
-- Job-based	 	 	 	
-- Uses tasks to calculate totals	 	
-- Shows job-to-date totals	 	
-- Based on job start dates	 	
-- Shows Income based on job billings	
-- Shows labor based on cost rate	 	
-- Reflects job cost transfers	 	
-- Shows open POs	 	 	
-- Can show profit by client, task, project, or job type

Job P&L

-- General Ledger-based
-- Uses G/L to calculate totals
-- Shows month-to-date account totals
-- Based on accounting periods (i.e., months)
-- Shows income on agency billings
-- Shows labor costs based on payroll
-- Doesn’t account for down time (includes down time as part of payroll)
-- Transfers don’t affect the G/L
-- POs aren’t reflected in job totals

Cost rates and profitability

Cost rates are important because they directly affect the job’s profitability. 
Time sheets use cost rates to calculate the cost amount of labor automati-
cally. The total cost of each time sheet increases the job task’s cost amount 
when time is posted. Costs rates are flexible, giving you complete control 
over rates for each staff member. Carefully choosing resource cost rates is an 
important and necessary step to make your profitability reports meaningful.  
Each staff has his or her own individual cost rate. For flexibility, cost rates 
are completely customizable. The staff’s cost rate is entered onto each time 
sheet automatically, but can be changed.

What if you don’t use cost rates on time sheets? Your profitability reports 
will be significantly affected. Your jobs will appear much more profitable, 
which is wrong. The job’s cost totals would show only vendor purchases and 
checks, and won’t reflect the value of your time. You’re not required to use 
cost rates, however. But if you don’t, be consistent—don’t use cost rates on 
any time for any job. And just be aware that when you look at a profitability 
report, the total profit doesn’t include labor.

Unbillable jobs and job profitability

Unbillable jobs can be included on the gross margin report if they have the 
same selections (billing status and start date) as other jobs. It’s a good idea 
to include these jobs on the report, since it makes your client totals more re-
alistic. Your total billings, costs, and margin for clients will be more accurate, 
since the cost of the unbillable jobs will be included.

To see the most accurate job totals, you should include your agency overhead 
jobs as well. To include these jobs, make sure they have a billing status and 
a start date. When you print a profitability report, enter the billing status that 
includes your agency jobs as well as the billable client jobs.

Job costing and profitability

It is important to be consistent about how you track job costs. On profitability 
reports, the cost total includes all vendor purchases, time sheets (using the 
resource’s cost rates), expenses, and checks written for job costs. The cost 
total is the total amount you’ve spent to complete the job (so far). If you 
don’t include all costs that you really incurred for a job, then your cost total 
will be too low—and the job’s profit will be overstated. Likewise, if you don’t 
enter time with accurate cost rates, the cost total won’t include the cost of 
the labor used to complete the work—and the job’s profit will be too high.

Tips for printing profitability reports

■ You can look at profitability from the production perspective and see a 
different picture than the agency profitability. This isn’t a problem. The two 
sides look at what you make and what you spend differently intentionally, 
providing insights into where the money’s coming from and where it’s going. 
Without these different points of view, there’s a big chance you’ll miss some 
key details. 

■ Knowing where your profit is coming from is much more important than 
knowing how much profit you’ve made. Because in an advertising agency or 
design studio, there are really only two ways to improve profits: get more cli-
ents and bill them for more jobs; or, know where you’re spending every dollar. 

■ All of the job profitability reports are based on job tasks. While the reports 
don’t show the tasks in detail, the costs and billings on these tasks are calcu-
lated and totaled on the reports. 
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Gross Margin by Job

 

Projected Gross Margin

 

Projected vs. Actual Gross Margin

Gross Margin by Client

Project Profitability

Division Profitability

Client vs. Client Gross Margin

 
Comparative Client Profitability

Projected Gross Margin by Client

Gross Margin by AE/Team

 
AE/Team Projected Gross Margin

 
AE/Team Projected vs. Actual Gross 
Margin

Gross Margin by Profit Center

Profit Center Projected Gross Margin

Profit Center Projected vs. Actual 
Gross Margin

The Gross Margin by Job report compares costs and profit for each job, subtotaled by 
job type. The net revenue is calculated based on the billings less direct costs, and 
the gross margin (or profit) is calculated by the net revenue less direct labor costs.

The Projected Gross Margin report calculates a projected gross margin based on 
the job’s estimate less the costs expected to be incurred to complete the job (i.e., 
budget).

The Projected vs Actual Gross Margin report compares the job’s actual gross margin 
to the projected gross margin. The job’s are subtotaled by job type. 

The Gross Margin by Client report shows the net revenue for every client’s jobs.

The Project Profitability report compares gross margin for jobs within each project.

The Division Profitability report compares profit between divisions and their clients.

The Client vs Client Gross Margin report shows the costs and profit for each client 
and calculates each client’s net revenue and gross margin.  

The Comparative Client Profitability report compares this year’s and last year’s profit.

The Projected Gross Margin by Client report calculates a projected gross margin 
based on the job’s estimate less the costs expected to be incurred to complete the 
job (i.e., budget) and the jobs are subtotaled by client.

The Gross Margin by AE/Team report calculates the net revenue and gross margin for 
each job and subtotals the jobs by AE/Team.

The AE/Team Projected Gross Margin report calculates the projected gross margin 
based on the job’s estimate less its budget. The job’s are subtotaled by AE/Team.

The AE/Team Projected vs Actual Gross Margin report compares the projected gross 
margin to the actual gross margin for each job and subtotals the jobs by AE/Team.

The Gross Margin by Profit Center report calculates the net revenue and gross margin 
for each job and subtotals the jobs by client, then by profit center.

The Profit Center Projected Gross Margin report calculates the projected gross margin 
figure for each job based on the projected billings (the job’s estimate) less the costs 
expected to be incurred to complete the job (the job’s budget). The job’s are subto-
taled by client, then by profit center.

The Profit Center Projected vs Actual Gross Margin report compares the projected 
gross margin to the actual gross margin for each job and subtotals the jobs by client 
and PC.

Job Profitability

Client Profitability

AE/Team

Profit Center

Profitability Reports
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Miscellaneous

Task Profitability

Task/Group Profitability

The Task Profitability report compares profit by client for each task.

The Task/Group Profitability report shows profit earned by each task 
and group.
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Productivity Reports

Productivity Reports

Productivity reports use time sheets to show how the shop’s time is spent. 
These reports are the best way see how people work—by client, job, or task. 
Productivity reports show the hours, cost amounts, and billable amounts 
for both billable and non-billable hours, so you’ll see a complete picture of 
your work.

Productivity reports show time by work date. Like time reports, productivity 
reports show hours posted from time cards and time sheets. But unlike time 
reports, productivity reports only show totals—so you won’t see individual 
time entries. This makes 
productivity reports much 
more concise (and prob-
ably more usable) than 
time reports.

Productivity reports don’t 
show billings. They’re less 
concerned with how the 
time was billed (or not 
billed) than with how the 
time was actually spent, 
since the cost of your staff 
is mostly fixed (unless 
they’re freelancers, that 
is). One reason for printing 
productivity reports is to 
see how time is being 
used, and especially if is it 
being managed properly. 
One of the reasons to 
track productivity is to en-
sure that the right people 
work on the right clients (i.e., the higher-paid staffers should only work on 
the most profitable clients, etc.).

Productivity reports can also help you balance your work load. If one staff 
member is consistently logging more hours than other staff, you’ll see it in 
their total hours—they’ll be higher than others. You can use this information 
to move work around, so that everyone is working more efficiently.  

Time reports vs. productivity reports

Productivity reports show time in summary, while time reports show time 
in detail. Productivity reports are designed to give managers a clear idea of 
how the staff spends their time over a week, month, quarter, or year. 

Time reports, in contrast, are designed for day-to-day time accountability. 
Time reports show every time entry, including a lot of extra information (like 
rates and descriptions) that is interesting but not meaningful to manage-
ment.  For productivity purposes, time reports simply show too much detail.  

Time reports are ideal, however, for seeing time before billing.  Since time 
reports show the time entry’s detail, they give you enough information to 
intelligently decide what to bill — and what not to bill.  

Tips for tracking staff productivity

■  Productivity reports for a long time period can take some time to print, 
depending on the quantity of time sheets selected.

■  Print productivity week-
ly to analyze how everyone 
managed their time.

■  The cost and billable 
amounts are totaled from 
time sheets using the 
task’s or staff member’s 
cost and billing rates.  If 
someone’s cost or billable 
amounts seem strange, 
print a time report for the 
same range of work dates 
to see the time details.  If 
you print both reports for 
the same time period, their 
totals will equal.

■  The cost and billable to-
tals on productivity reports 
combine the different rates 
used on the staffer’s time 
sheets.  Your billable totals 

will reflect different rates for different tasks on time sheets added for the 
selected time period.

To print productivity reports

1 Choose Snapshots > Productivity.

2  Select the kind of report (i.e., General, Staff Utilization, Dept Performance, 
Client Analysis, Profit Centers)

3 Make your report selection.

4 Click Print.
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Daily Department Time Analysis

Weekly Time Summary, Analysis

Missing Time

Overtime

Staff Utilization

YTD Staff Utilization by Client

Freelance Time Analysis

Unbillable Time Analysis

Billable/Unbillable Time Summary

Staff Realization

Dept/Group Productivity

Team Productivity

Team/Staff Productivity

Monthly Client Time Summary

Client Productivity by Job

Division Productivity

Division/Client Productivity

Division/Staff Productivity

Profit Center Productivity

Profit Center/Client Productivity

Profit Center/Staff Productivity

Productivity Reports

Productivity reports 

The Daily Dept Time Analysis report shows total hours by day for everyone who worked, 
including planned vs. actual hours by day for each staff member and department.

The Weekly Time Summary report shows total hours spent for each staff member for a 
7-day period, subtotaled by department. The Weekly Time Analysis report shows total 
hours spent for each staff member and the jobs they worked on for a 7-day period, 
subtotaled by department.

The Missing Time report lists each staff member by department showing their planned 
hours vs. their actual hours. It shows who hasn’t accounted for all of their time.

The Overtime report only shows time entries marked as “overtime”.

This report compares each staff member’s total hours vs. their billable hours.

The YTD Staff Utilization by Client report compares period vs. year-to-date staff time.

The Freelance Time Analysis compares client hours for employees vs. freelancers.

This report compares the percentage of unbillable staff time by client.

The Billable/Unbillable Time Summary report compares billable to unbillable hours. 

The Staff Realization report compares each staff member’s total hours vs. their billed 
hours. The report is based on what percent of their total hours has actually been billed.

This report compares each staff member’s total hours vs. their billable hours by depart-
ment.

The Team Productivity report compares each team’s total hours vs. their billable hours 
and calculates the team’s utilization (percentage of billable hours).

The Team/Staff Productivity report compares each staff member’s total hours vs. their 
billable hours. The staff members are subtotaled by team.

The Monthly Client Time Summary report shows total hours worked by staffer per client. 

The Client Productivity by Job report shows total hours worked by job and client.

The Division Productivity report compares each division’s total hours vs. billable hours.

The Division/Client Productivity report analyzes total hours for each division and client.

The Division/Staff Productivity report compares staff hours by division and client

This report compares each PC’s total hours vs. billable hours to calculated its utiliza-
tion.  

This report analyzes each profit center’s total hours and billable hours for each client.

The Profit Center/Staff Productivity report shows total hours by staff worked by PC.

General

Staff Utilization

Profit Centers

Client Analysis

Dept Performance
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Financials

Clients & Profits X prints standard financial statements tailored especially for 
the advertising industry. These financial reports are used for auditing, track-
ing, and reporting your G/L accounts balances. You can print trial balances, 
income statements, balance sheets, and detailed general ledger reports for 
any accounting period—at any time during the month.

Financial statements show account balances from the General Ledger and 
the Chart of Accounts. These account balances are updated when entries 
are posted, so the financial 
statements are always timely 
and accurate whenever they’re 
printed. 

The account totals on the 
financial statements are copied 
from the Chart of Accounts. (To 
see one account’s totals: Choose 
Setup > Chart of Accounts. Click 
once on an account to select 
it, then choose Edit > Monthly 
Budgets. The center column, 
actuals, is the total from posted 
entries.) Entries added in the 
General Ledger affect financial 
statements when they’re posted. 
Unposted entries won’t appear on 
financial reports. 
Be sure to post everything before 
printing financial statements.

■  There is no month-end procedure required to print financials. Since the G/L 
account balances are updated whenever entries are posted, your financial 
statements will always be up-to-date throughout the month.

The AGI Income Statement

The income statement shows the agency’s profit and loss. There are two 
kinds of income statements, the standard form and the agency gross income 
form. Both forms show the same accounts, but have different subtotals. These 
subtotals affect how the percentages are calculated.

The standard income statement subtotals income accounts, job cost ac-
counts, and expense accounts. Gross profit is calculated as billings minus job 
costs. A gross profit percentage is calculated showing job costs as a fraction 
of the total billings. An account can appear in the income or job cost section, 
based on its classification (which is user-defined). Expenses are listed below 
the gross profit. The expense percentage for each overhead account is calcu-
lated as a percent of the billings, not gross profit. This calculation shows your 
ratio of overhead to total billings.

The AGI income statement combines your billing and job cost accounts into 

the same section. The gross profit is calculated as the billings minus job 
costs (like media, typesetting, printing, etc.). This amount is your agency 
gross income. Expenses are listed below the AGI. The expense percentage for 
each overhead account is calculated as a percent of gross profit, not billings. 
This calculation shows the ratio of overhead to gross profit—the agency’s 
gross income.

To print financials

1  Choose Snapshots > Financials.

2  Select the kind of report (i.e., 
Trial Balance, Detail G/L, Income 
Statement, etc.)

3  Make your report selection.

4  Click Print.

Tips for printing finan-
cials

■ Financial reports can be printed 
to the screen for quick review, 
before the report is committed 
to paper.

■ Financial statements can be 
printed for previous periods—even if the period is locked—by choosing the 
period from the pop-up menu. 

■ Unless a period is locked, anyone can post entries into prior periods. This 
means your past financials might change after they’ve been printed. If some-
one adds costs or billings after you’ve printed the month’s financials, be sure 
to reprint the reports over again.

■ Account totals on financial statements can be audited by printing audit 
trails and journals from the General Ledger. 

■ If your audit trails and journals don’t equal the financial statements, post-
ing may have crashed during the month. Use the verify G/L account balances 
utility to recover the correct totals.

■ The date and time a financial statement was printed appears at the top of 
each report. When you’re printing financial reports repeatedly, use this date 
to determine the most-recently printed report.
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The Trial Balance shows assets, liabilities, equity, income, costs, and expenses. 
You’ll see each account’s beginning balance, current balance, and ending balance. 
Assets, costs, and expenses have positive balances; liability, equity, and income ac-
counts have negative balances.

The Year-to-Date Trial Balance report shows balances for each accounting period for 
assets, liabilities, equity, income, job costs, and expenses—for the entire year. The 
report is split into two sections: the first six months and the last six months.

The Trial Balance Worksheet shows each account’s current and ending balance plus 
two blank columns, so the printed report can be used as a worksheet to calculate 
adjustment and adjusted balance amounts.

The Detailed General Ledger report shows the period’s journal entries for each ac-
count. Each account includes its beginning and ending balances for quick reference. 
For easy auditing, journal entries can be printed for selected accounts.

The Detailed G/L (expanded) report shows all the information on the Detailed G/L 
along with each journal entry’s job, client, and vendor information.

The Income Statement shows income, job cost, and expense accounts as well as net 
profit/loss for the shop. The standard format shows gross profit as billings less job 
costs. It also shows expense ratios as part of total billings. The AGI format shows 
expense ratios as part of gross profit, not total billings. 

The Comparative Income Statement compares this years income, job cost, and 
expense accounts to the amounts from last year.

The Client P&L report shows billings, direct costs, gross profit, and gross profit by 
client. Unlike the Client P&L Analysis, it does not break out each client’s share of 
overhead.

The Client P&L Analysis shows each client’s income, costs, direct labor, direct 
expenses, plus their share of the overhead allocation. The net income earned is 
calculated by client.

The Job P&L shows billing, direct costs, expenses, and gross margin for one period.

The Balance Sheet shows ending balances for assets, liabilities, and equity. It shows 
your net worth.

The Comparative Balance Sheet compares assets, liabilities, and equity between two 
fiscal years.

Financials

Financial Statements

Trial Balance

Year-to-date Trial Balance

Trial Balance Worksheet

Detailed G/L

Detailed G/L (expanded)

Income Statement

Comparative Income Statement

Client P&L

Client P&L Analysis

Job P&L

Balance Sheet

Comparative Balance Sheet

Trial Balance

Detailed G/L

Income Statement

Balance Sheet
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The Budget vs. Actual report compares each G/L account’s budget with its current 
balance. Budgets are entered for each account in the Chart of Accounts. You’ll have 
the option to compare month-to-date and year-to-date totals, including percentage 
variances.

The Comparative Budget vs. Actual report compares G/L account budgets with actuals 
for the current period and the year-to-date.

The Monthly Budget Worksheet lists G/L accounts with the current month’s budget. An 
extra column is included to make manual revisions, which would be entered later into 
the Budget Worksheet window.

The YTD Budget Worksheet lists G/L accounts and their year-to-date budgets, plus an 
extra column for making revisions to the budget amounts.

The Proforma Income Statement projects the shop’s income using the period’s bud-
gets.

The Statement of Cash Flows report uses each G/L account’s cash flow category to 
calculate operating, investing, and financial activities totals for the period.

This report shows detail of the amounts on the Statement of Cash Flows. It is used to 
analyze the amounts use to calculate the totals shown on the Statement of Cash Flows.

The Media WIP Analysis report is used to audit balance of the Media WIP Accruals 
liability account, which is updated from media billing and vendor invoices.

The Liquidity Analysis report measures the ability of the company to meet cash re-
quirements. It’s based on the ratio categories entered for each G/L account.

The Profitability Analysis report measures how well the company is utilizing its re-
sources

The Solvency Analysis report measures how the company’s financial health with ratios 
such as debt-to-equity, cash flow to interest, debt-to-assets, and more.

Budget vs. Actual

Comparative Budget vs. Actual

Monthly Budget Worksheet

YTD Budget Worksheet

Proforma Income Statement

Statement of Cash Flows

Cash Flow Detail Report

Media WIP Analysis

Liquidity Analysis

 
Profitability Analysis

Solvency Analysis

Financial Statements (con’t)

Budgets

Analysis

Ratios

Financials
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Clients & Profits Sample DATA 08/20/98, 10:14 AM, Page 2
Balance Sheet
For period 3 - March
Profit Center: ALL

LIABILITIES AND EQUITY

Current Liabilities:

Accounts Payable - Production $ 342,560.19
Sales Tax Payable $ 9,474.04
Client Deposits/Advances/Retainers $ 157,047.87
Media Payables $ 35,823.20

Total Current Liabilities: $ 544,905.30

Long-Term Liabilities:

Note Payable - Bank of America $ 136,000.00
Unearned Rent $ 9,560.16
Deferred Taxes $ 123,067.00

Total Long-Term Liabilities: $ 268,627.16

Equity:

Common Stock $ 25,000.00
Paid-in Capital $ 31,570.54
Retained Earnings $ 333,705.17
Suspense $-17,911.78
Current Earnings - 1998 $ 43,893.14

Total Equity: $ 416,257.07

TOTAL LIABILITIES AND EQUITY $ 1,229,789.53

Unregistered Clients & Profits X 05/22/07, 3:36 PM, Page 1

Balance Sheet
For period 15 - March
Profit Center: ALL All

ASSETS

Assets:

name $7,479.85
name $5,345.00

Total Assets: $12,824.85

Current Assets:

Cash $-1,576.00
Petty Cash $-396.00
Petty Cash $0.01
Cash - Bank of America $313,868.89
Accounts Receivable $-170.30
Accounts Receivable - Production $-54,200.18
Accounts Receivable - Media $107,644.38
Accounts Receivable - Retainers $-28,920.00
Work In Process $16,758.79
Amortized Expenses $20.00
Prepaid Taxes $-20.00
Prepaid Computer Services $1,068.75
Employee Advances $2,153.00

Total Current Assets: $356,231.34

Long-Term Assets:

Notes Receivable $10,692.91
Notes Receivable $-50.00
Amortized Supplies $-10,113.73
Amortized Professional Fees $3,424.96
Amortized Prop. Insurance $-2,361.94
Equipment $-1,000.00
Furniture & Fixtures $-12,842.87
Office Equipment $56,207.26
Automobiles $-4,145.17
Computer Equipment $32,060.10
Office Equipment $-4,440.11
Fine Art $-3,092.77
Leases - HP Fax $-2,164.90
Accum Dep - Furn & Fixt $15,617.74
Accum Dep -  Office quip $6,337.00
Accum Dep - Automobiles $18,106.70
Accum Dep - Computers $-1,985.77
Accum Dep - Office Equip $-7,640.10
Accum Dep - Telephone PBX $9,224.70
Notes Rec - Officers $-4,192.10

Total Long-Term Assets: $97,641.91

TOTAL ASSETS $466,698.10

Unregistered Clients & Profits X 05/22/07, 3:36 PM, Page 2

Balance Sheet
For period 15 - March
Profit Center: ALL All

LIABILITIES AND EQUITY

Liabilities:

Notes Payable $-55.00

Total Liabilities: $-55.00

Current Liabilities:

Accounts Payable - Production $-122,996.67
Sales Tax Payable $77.54
Sales Tax Payable - Out-of-State $207.59
Client Deposits/Advances/Retainers $2,850.15

Total Current Liabilities: $-119,861.39

Equity:

Suspense $1,900.00
Current Earnings - 2006 $-6,892.22
Current Earnings - 2007 $3,106.28

Total Equity: $-1,885.94

TOTAL LIABILITIES AND EQUITY $-121,802.33

Out of Balance (see Out of Balance Checker utility): $588,500.43
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Media Analysis Reports

Media Analysis reports

Clients & Profits X prints three kinds of media analysis reports: post-buy, 
client spending, and group performance. Post-buy reports are used by media 
buyers to see in detail the media buys that were ordered on broadcast and 
insertion orders. Post-buy reports can subtotal media buys by client or sta-
tion/publication. Client spending reports are used by account service to show 
clients how and where their advertising budget has been spent. Finally, the 
agency’s management can use group performance reports to analyze how 
well the media department is managing themselves. 

Media goals and media reports

The Media Group Performance 
- Trend Analysis report compares 
actual media spending for each 
kind of media (e.g., broadcast 
TV, radio, etc.) with the media 
department’s billing goals. For 
these reports to work properly, 
the shop’s billing goals for each 
media kind must be entered in 
the Media Goals window. Media 
billing goals, which are based 
on gross amounts on broadcast 
and print insertion orders, can be 
entered for each quarter of the 
calendar year. For more informa-
tion 
about media goals, see the Media 
chapter.

To print media reports

1  Chose Snapshots > Media 
Analysis Reports.

Media reports are grouped 
together by category (i.e., 
Status, Traffic, Post-Buy, 
etc.). Each category has a 
collection of media reports 
that can be printed. Only one 
report can be printed at a time.
 
3  Select a report category to show 
the reports that can be printed. 

4  Choose a report by clicking on a report 
name.

5 Enter a range of dates and select any available options.

Post-buy, client spending, and group performance reports are based on media 
buys from broadcast orders and insertion orders. These reports will select 
media buys from the broadcast or insertion order’s order date.

6  Click Print.

■  Any print or broadcast media plan that is marked as “closed” or “inactive” 
will not be included on media status reports or media traffic reports.

Media reports help different de-
partments manage clients.  Status 
and traffic reports track the day-
to-day media plans and estimates. 
Post-buy reports help media 
buys track what’s been ordered. 
Account service can use client 
spending reports to analyze each 
client’s media spending. Group 
performance reports summarize 
how well the media department 
manages spending trends, client 
media profitability, and spending 
volumes.
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Media Snapshot Reports

Post-Buy Reports

The Media Recap lists buys on insertion and broadcast orders for a selected date range and sorts 
them by client or pub/station and month, showing the issue/flight date, ad size/program, and 
more.

This report lists any insertion or broadcast order discrepancies between the gross and net 
amounts ordered vs. the actual gross and net amounts invoiced by the publication or station. 
The report includes each buy’s A/P number and A/P date. It can be printed by client or pub/
station.

The Reconciliation report compares an insertion or broadcast order’s gross/net amounts vs. the 
actual gross/net amounts invoiced by the publication or station. It shows the A/R invoice number 
the IO or BO was billed on and whether a client payment is posted, and the A/P invoice number 
the IO or BO was applied to and whether a vendor payment is posted. 

The Mix Analysis report compares total spending with quarterly totals for each kind of media for 
all clients and all stations/publications.

The Market Analysis report compares TV/radio spending by quarter for each market (which is 
optionally entered on each broadcast order or insertion order)

The Product Analysis report compares TV/radio spending by quarter for each product, using the 
user-defined “product” field on broadcast and insertion orders.

This report summarizes media spending by client by quarter for each station or publication.

The Division Analysis report summarizes media spending for each division and its clients. It 
helps AEs track the total spending for corporate clients that have many business units or groups.

The Monthly Media Analysis report summarizes total media spending for each month of the cal-
endar year for each station/publication. This report helps media buyers and account supervisors 
analyze which stations and publications are getting the most media dollars from the agency.

The Trend Analysis report compares quarterly media spending vs. the media department’s spend-
ing goals. It shows how the shop’s media spending is changing from the beginning of the year.

This report analyzes media billings, cost, gross profit, and average commission for each client’s 
media spending. The report is based on the gross and net amounts from the client’s media 
orders.

The Commission Analysis report analyzes commissions generated by each different type of 
media (e.g., broadcast TV, radio, newspaper, etc.) for each client. It calculates the commission 
based on the order’s total gross and total net. The commission is not calculated on the actual 
net cost from the vendor’s A/P invoice or the gross amounts from the client’s A/R media invoice.

The Buyer Analysis report compares each media buyer’s billings, costs, and commissions for 
each client. The year’s totals are compared to last year’s to highlight any improvements (or 
decreases) and  calculates the average commission for each media buyer. These totals are based 
on broadcast orders and insertion orders, and not calculated on the actual billings from A/R or 
actual costs from A/P. This report can be useful for measuring the performance of each media 
buyer.

This report summarizes gross and net totals (as well as calculating the average commission) for 
each different kind of media. Totals are shown for each station or publication for broadcast TV, 
radio, etc. The report calculates the percentage increase/decrease in billings for each station/
publication.

Media Recap

Discrepancy

Reconciliation

Mix Analysis 

Market Analysis (TV/Radio)

	
Product Analysis (TV/Radio)

Station/Publication Analysis

Division Analysis

Monthly Media Analysis

Trend Analysis

Client Profitability

Commissions Analysis

Buyer Analysis

Media Vendor Volume Analysis

Client Spending Reports

Group Performance Reports

Media Analysis Reports


